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SUMMARY

The CAMD system is designed to assist corpsmen in rendering a medical diagnosis. The
CAMD system was written in FoxPro Version 2.0, a database management system. The signs,
symptoms, and laboratory information collected by the Abdominal and Chest modules can be
gathered on the standard forms developed for CAMD, or entered directly (real time) into the
system. The Chronological Record of Medical Care (SF600) can then be generated to document
an encounter. Additionally, information from the disease and treatment files can be added to the
SF600.

The CAMD system User’s Guide was written to introduce the Independent Duty
Corpsmen to this software system, explaining the Keyboard and Mouse commands necessary to
run the various options, and displaying the screens associated with them.
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Section 1 Introduction

1.1  Purpose of the Computer Assisted Medical Diagnosis (CAMD) System Users’ Guide.
The objective of the users’ guide is to provide personnel, who may be unfamiliar with personal
computer software, the information necessary to effectively use the CAMD system. Additionally,
this guide will supply the users with a detailed description, as well as, the basic structure and
features of the CAMD system.

1.2  Computer Assisted Medical Diagnosis (CAMD). Medical care on board many small
ships and submarines is rendered by specially trained independent duty corpsmen. These vessels
often operate in remote areas where these corpsmen cannot easily obtain consultations.
Therefore, the Navy Medical Research and Development Command (NMRDC) initiated a
program to develop a set of diagnostic algorithms that could be automated. The objectives of
this effort are:

a) Provide medical practitioners with accurate medical diagnostic and treatment
information.

b) Prevent unnecessary, hazardous, and disruptive medical evacuations by providing
diagnostic assistance to independent duty corpsmen.

©) Improve communications between isolated independent duty corpsmen and their
supporting medical officers by providing a standardized method for information
collection.

d) Gather clinical information in a modifiable diagnostic knowledge base to ensure
diagnostic accuracy.

1.3  References. The following references provide technical and background information for
CAMD.

FoxPro Commands & Functions, Fox Software, Inc., Perrysburg,Ohio, 1991.

ICD- 9 CM, International Classification of Diseases 9th Revision, U.S. Dept. of Health
and Human Services, 1980.

Abdominal Pain - A Decision Support System for the Management of Acute Abdominal
Pain Version 3.0 - Programmer’s Manual, Naval Submarine Medical Research Laboratory
Technical Report NSMRL 1148, Groton, CN, 1989.
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Chest Pain - A Decision Support System for the Management of Acute Chest Pain

Version 3.0 - Programmer’s Manual, Naval Submarine Medical Research Laboratory Technical
Report NSMRL 1148, Groton, CN, 1989.

14

Terms and Abbreviations.

Carriage Return <CR>. Notation used to denote a carriage return typically executed
by pressing the "ENTER" or "RETURN" key on a computer keyboard. If a mouse is
available on the computer system, "click" or press the top left button for a return.

Database Management (DBM). A management approach to database design consisting
of what information is collected, where information stored, and how it is processed by

computer software.

Default. A response assumed by CAMD. If the default value is correct, the user need
only press the "ENTER" or "RETURN" key.

Expert System. A computer program which emulates the behavior of a human expert
in a specific area of knowledge.

FoxPro. A database management development system written by the Fox Software, Inc.
FoxPro Version 2.0 was used to develop the CAMD system.

SAMS. SNAP Automated Medical System Version 7.0 is a FoxPro software application
for handling shipboard medical department forms, files and data.

SNAPS. Shipboard Non-tactical ADP Program.

System. The combination of hardware, firmware, and software designed to function as
an integrated unit.

SF600. The Chronological Record of Medical Care standardized form used for
documenting a medical encounter.
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Section 2 System Summary

2.1  System Application. On U.S. Navy submarines and small surface ships medical services
are provided by independent duty corpsmen. To assist the corpsman and enhance their
diagnostic skills, the U.S. Navy has initiated the development of CAMD system.

2.2  Programming Language. The CAMD software was written in the FoxPro Version 2.0
programming language. FoxPro is a database management software system created for the
personal computer to produce computer applications.

2.3  Security/Privacy. The security module will maintain user passwords which allow log-on
access to the program and database files. Menu options are assigned to the user through a
security key system in FoxPro. CAMD collects and stores data covered under the 1974 Privacy
Act.

2.4  Flexibility. Since CAMD was created by using the FoxPro utilities, enhancements and
updates to the system can be accomplished with minimal programming. CAMD was design to
compatible with SAMS.

2.5 Maintenance. The primary maintenance functions consist of security options, file and
format definitions, user file updates, knowledge base editing, and initialization of data.

2.6  Error Messages. When installing the system the two major error messages that may
occur are "Too many files open” and "Out of Environment Space."

2.6.1 Too Many Files Open Error Message. If the "Too many files open" message occurs,
the following window will open. Select the <Cancel> button to end the program. Return to
the root directory (cd c:\) and modify the CONFIG.SYS by adding or editing the FILES
command to minimum 50. Example: FILES = 75. If the system does not have an editor then
see EDLIN command in the MS-DOS manual.

Too many files open

> <Ignore>

2.6.2 Out of Environment Space Error Message. If an "Out of Environment Space" occurs,
change the CONFIG.SYS file. Return to the root directory (cd C:\) and modify the
CONFIG.SYS by adding the SHELL command.
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The Shell command should appear as follows:
SHELL=COMMAND.COM /P /E:512 (DOS Version 3.2 and above)
SHELL=COMMAND.COM /P /E:32 (DOS Version 3.1 and below)

The "/P" will make it permanent and the "E/:(size)" will expand the environment space
from the default of 160 bytes. Reboot the system after changing the CONFIG.SYS.

2.7 System Organization. The system has five main menus which are (1) System, (2)
File, (3) Edit, (4) Diagnosis, and (5) Window. Accessing the system requires a password, see
Section 3. Once the password is successfully entered, the following screens will appear:

System File Edit Diagnosis Window

Computer Assisted Medial Diagnosis System
Version Release 1.0
by
Naval Health Research Center

Press the F1 key for help

CAMD main menu

COMPUTER ASSISTED MEDICAL DIAGOSTIS

The Computer Assisted Medical Diagnosis (CAMD) system contains disease description
and treatment recommendations, as well as diagnostic assistance for two areas; Abdominal Pain)
and Chest Pain. Only the most common diseases in each category are considered for medical
[diagnosis. The Non-Specific disease in each area represents non-surgical, non-lif
threatening cases, which in general do not require evacuation.

YOUR JUDGEMENT MUST TAKE PRECEDENCE, the CAMD system cannot make the subjectivi
evaluations which are often so important in medical diagnosis.

When using the CAMD system the lines at the bottom of the screen will indicate which
keys to select. The <F1> key will give additional help and when available, display]
explanations or definitions of items or terms.

Press any key to continue...

CAMD brief greeting screen
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2.8 System Menu Options. The following figure shows all options of the CAMD system.
The system is operated using either a mouse or the keyboard to select the menu options
described in Section 3.

afeRite . - voliEdiv iagnosis
Help... F1 Reindex Undo Register Patient Cycle
Quit Redo Encounter Color...
SF600 Report
Change Password Cut Disease/Treatment
Backup Copy Lookup Ii
Restore Paste
Clear
Calcutator Select All Encounter Training
Calendar/Diary Mode -
Goto Line...

CAMD System Menu Options
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Section 3 Accessing the System

| 3.1  Entering CAMD (log-on). Change the current directory to CAMD or the one in which
CAMD was installed on the system (C:\CAMD). At the MS-DOS prompt, type CAMD and the
following security prompt will be displayed.

Unauthorized access to this United States Government Computer System and/or
software is prohibited by title 18, United States code; section 1030. This
system may only be used for unclassified official business.

Enter Password:

CAMD System Log-On Screen

Type in the password and <CR>. After an acceptable password has been entered a
brief greeting will be shown.

(C) Naval Health Research Center, San Diego, Ca.
R R R R R R R TR R R R R AR R

If problems occur please contact:
Ms. D. M. Pearsall (Dee)
Naval Health Research Center
P.O. Box 85122
San Diego, Ca. 92186-85122
DSN 553-8401 or Com (619) 553-8401
R R R R R R R R R R R
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3.2

Exiting the CAMD (Log-off). Choose Quit from the File Menu options to exit the

CAMD system. If any windows are left open, the system will ask if the user wants them closed.
Select the < Yes> option.

3.3

3.4

System | Fite | Edit Diagnosis Window

Reindex

Mouse Techniques

Point - Position the pointer at the specific location on the screen. When moving the
mouse, the pointer moves in a similar manner.

Click - Point to an object then press and release the mouse button once.

Double click - Point to an object then press and release the mouse button twice in rapid
succession.

Drag - Hold the mouse button down, roll the mouse until the pointer is in the desired
location and release the mouse button.

Choosing A Menu
Keyboard:
1. Press the Alt key to select the first menu pad, then press the Right

or Left Arrow keys to select other menu pads on the menu bar.
Or Press the Alt key in conjunction with the highlighted letter of

the menu pad.

2. Press <CR> to display the menu popup window.
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3. Press the Up or Down Arrow keys to select an option then press
<CR> to choose the option or enter the highlighted letter of the
option and press <CR>.

Mouse:

1. Point to the menu pad and press the left mouse button to display the menu popup

window.
2. Point to the desired option and press the left mouse button.
Menu Pad
I
v
[[Bystem [File dit Diagnosis Windows
> enu_Po {Reindex
Quit «— Menu Option
Menu
Bar

3.5 Dialogs. Dialogs are special boxes for the data entry that allow the user to choose the
action about to take place.

Backup CAMD database:

{..1
[p0C)
CAMD9202.Z1P

I « EREARRTEEE > B
Al

Backup Filename:

Scrolling List

Drive

Direc

A
L Enter_text box

C
= Popup
button
tory CAMD

« Open » <«— Default
push button

< Cancel > «— Push button
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Scrolling a list
Keyboard:

1. TAB to the list.
2. Press the Down Arrow key or UP Arrow Key

Mouse:

1. Click on the up or down arrow on the scroll bar.
2. Holding down the mouse button will cause the scrolling to continue until released.

Choosing an Option on a Popup

Keyboard:

1. Tab to the popup control, then press <CR> to display the popup.
2. Press the Up or Down Arrow keys to select the option then press <CR>.

Mouse:

1. Point to the popup control and press the mouse button to display the popup.
2. Drag to the desired option, then release the mouse button.

Choosing a Check Box, Radio Button, or Push Button

Keyboard:

1. TAB to the check box, radio button, or push button.
2. Press <CR>.

Mouse:

1. Point to the check box, radio button, or push button.
2. Press the button (click).
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3.6 On-Line Help (F1). With the CAMD system, help is always close at hand with the F1
key. CAMD provides context sensitive help that can be accessed by pressing F1 or selecting
the Help option on the System Menu. Questions concerning windows or dialogs can be answered
by pressing the <F1> key.

YyYYyYYYYYY

— B
DATA ENTRY A
REGISTER PATIENT |
PATIENT DETAILS i
v
]

CAMD
Systolic
Temperature

CAMD Help Topics Level Window

< Next

« Topics »

<Previous>

< Look Up>

Help
Choose the item you wish to run from the Menu. Use the cursor Up or
> bDown arrow keys to highlight the desired item, then press the Enter key

available.

1. Register Patient
This option allows you to register a patient, review existing patients

See Also

records, or select a patient for a medical encounter.
The selected patient record is opened for the encounter described in

Option 2 below.

2. Patient Encounter
This option allow you to start a patient encounter, register the patient,
enter the encounter details, including all the relevant signs and symptom v

A
.
to select it. For the CAMD diagnostic module, the following choices are |

CAMD Help Detail Level

Computer Assisted Medical Diagnosis
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To see help details for a topic, select the < <Topic> > and press <CR> or double-
click on the topic the window or Spacebar. For more information on a topic, use the scroll bar.

To return to the topics level of the Help window and select another topic, choose
<Topics>. To see information about the next topic, choose <Next>. To see information
about the previous topic, choose <Previous>. The <Look Up> and See Also functions are

not used by the CAMD system.

To close the HELP window using the keyboard press the escape key <ESC>. To close
using the mouse point to the small white rectangle in the top left corner of the window and click.

3.7 Text editing. A text editor allows the user to type and modify information displayed in
a region of the screen (e.g., Treatment or SF600 Report). When text editing, use the cursor to
move through the text. The cursor looks like a flashing underscore, when in the insert mode,
and a flashing box when in the overwrite mode. Press the <Insert> key to switch between
modes. It is easy to move the cursor through text using eight basic keys. Four of these keys can
also be used in combination with a modifier key < Ctrl> to move the cursor a greater distance.
See Appendix B for The Table of Text Editor Commands.
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Section 4 System Transactions. To access the top level menu options using

the mouse, point to the option and click. To use the keyboard press down the <ALT > key and
the first letter of the option. Example: < ALT > D to reach the Diagnosis Menu.

Diagnosis Window

4.1  System menu. System Menu options are used for file maintenance and desk accessories.

Edit Diagnosis Window

Help...F1

Change Password
Backup

Restore

Calculator

Calendar/Diary

4.1.1 Help <F1>. The Help option displays the Help Window described in Section 3.6.

4.1.2 Change Password. This options let the users change the password. When Change
Password is chosen from the System Menu, type a new password and press <CR>. Remember
this change is permanent, so memorize the new password or make a notation and place it
somewhere safe.

Enter Password:
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4.1.3 Backup. Backup is used to copy the database to another file. In the example the file
was named CAMD9203. The 9203 represents the year and month in which the files were
backed-up. To backup the files select the disk drive and directory where the file is to be stored,
enter a name for the backup file, and select < <Open> >. The system will automatically begin
this process and display a message when finished.

Backup CAMD database:

[..1
[ooc]
CAMD9202.BCK

Drive

Directory

W < A >

Backup Filename:

< Cancel >

4.1.4 Restore. This option allows the user to restore or reinstall the database previously
backed up by the CAMD system. To restore a backup file enter the disk drive and directory
where the backup file was stored, enter the name of the file, and select < <Open> >. The
system will automatically begin this process and display a message when finished.

Restore CAMD database:

[..]

[DOC]
CAMD9202.8CK
CAMD9203.8CK

Drive

|

A

| Directory
v

]

Restore Filename:

CAMD

< Cancel >
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4.1.5 Calculator. When the user chooses the Calculator option from the System Menu popup
a graphic of a calculator appears on the screen. This Calculator used like a standard pocket
calculator. Calculations can be performed either using the keyboard or the mouse.

To perform the calculation with the mouse, simply click on the appropriate numbers and
symbols on the calculator.

With the keyboard, type the equation as it would be written. Most Calculator keys have
the same keyboard equivalents, with the following exceptions:

v
MR

+
M+
MC

M-

O INIP»IZ " |0

Calculator
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4.1.6 Calendar/Diary. When the user chooses the Calendar/Diary option from the System
Menu popup, a monthly calendar appears with the current day selected. This calendar is used
just like any other calendar to check dates and keep track of appointments. The first time the
this option is used the current day is select as a default. If the user wants a different day, the
Calendar Window must first be closed, and then reopened. The default then becomes the last
day selected. To close this menu option, press the <ESC> key or click the close box option.

System File Edit l, Diagnosis Window l Diary AJ

August 92
Tu We Th

<Y - > <Today>

To the right of the Calendar panel is the Diary panel. Use the Diary panel to input text
associated with any date on the calendar panel. To activate the Diary panel, press the TAB key
or choose Diary from Diary Menu Popup. To activate the Calendar panel, press shift+Tab or
choose Calendar from the Diary Menu popup. Refer to Appendix C for more information.
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4.2  File Menu. The File Menu contains options for manipulating data files. Currently there
are only two options on this menu Reindex and Quit.

System File Edit Diagnosis Window
Reindex

4.2.1 Reindex. This option is used to reindex or sort the database files. When the user
chooses the Reindex option from File Menu popup, a brief message will be displayed. The
window will disappear when the task is completed.

4.2.2 Quit. The Quit option ends current CAMD session. When chosen, a message will be
shown on the screen, and will return to the MS-DOS prompt (C:\CAMD).

4.3 Edit Menu. The Edit Menu options are used when editing the Treatment Section of the
Encounter, and SF600.

System T File Edit Diagnosis n
uUndo

Redo

Cut

Copy

Paste

Clear

Select All

Goto Line...

4.3.1 Undo. Reverses the last action that was performed while text editing. Selecting the Undo
option repeatedly will reverse all entries made during the current editing session.
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4.3.2 Redo. This is the opposite of Undo. Choose Redo to restore the text to its previous
condition. Selecting this option will reverse the Undo option.

4.3.3 Cut. Removes selected text from any field, record, or text editing field.

4.3.4 Copy. Duplicates the selected text (without removing it) and places the copy on the
clipboard.

4.3.5 Paste. Inserts a copy of the clipboard contents into the current file, field, text editing
window at the cursor location. It will replace the contents of the clipboard with the selected

text.

4.3.6 Clear. Clear permanently removes selected text or data without placing it on the
clipboard. If the user chooses this option when text is selected, the result is the same as
pressing the < Delete > or < Backspace > keys. Additionally, the Clear option is used to
erase a window or the desktop.

4.3.7 Select All. All lines of text in the current editing window are selected.

4.3.8 Goto Line.... Displays the Goto Line dialog to move the cursor to a designated line in
a text window.

Line Number: _
« Goto » < Cancel >

In the Line Number text box, type the number of the line the cursor is to appear. When
this option is chosen, the cursor moves to the beginning of the specified line, and the text of that
line is displayed in the window. If the line number specified is greater than the number of lines
in the window, the cursor is positioned on the last line.
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4.4 Diagnosis. Currently, CAMD has two medical areas; Abdominal Pain and Chest Pain.
Each area has its own medical diagnosis, disease, and treatment databases. The diagnosis data
is group by disease categories, where only the most common diseases are considered. The
Diagnosis Menu is the main menu for the CAMD system. Use the <Tab> <CR> keys to
select options on the keyboard. Below are the five major functions:

System: . ] File | Edit Diagnosis . . [ Vindow
Register Patient
Encounter

SF600 Report
Disease/Treatment Lookup
Encounter Training Mode

4.4.1 Register Patient. This option allows the user to select, edit, search the SAMS data files,
register a patient, and review existing patient records.

System File Edit Diagnosis Window

SF600 Report
Disease/Treatment Lookup
Encounter Training Mode

PATIENT SELECTION
Social Security: - -

Last Name:

First Name:

« OK » < BROWSE > < CANCEL >

This window allows the user to 1) Browse the entire database looking for a patient, 2) enter
partial information about the patient, 3) select a patient from a candidate list, 4) add a new
patient, or 5) cancel the selection process.

Computer Assisted Medical Diagnosis % 18




4.4.1.1 Browse.

To lookup up a patient with <Browse> using the keyboard press the

<Tab> key until the cursor is located on top of the button, then press <CR>.

PATIENT SELECTION

Social Security:

Last Name:

First Name:

To select a patient move the cursor to the correct patient (arrow keys on the keyboard).

If the information is 1) correct choose the <Select> button on the window, 2) incorrect select
the <Edit> button, and 3) not found press the <Cancel> button.

PATIENT FILE

[222222222]
[333333333]

ARNOLD, ROSANNE
ZEE, ZORRO

< Edit >

< Cancel >

4.4.1.2 OK. This option allows the user to enter partial numbers or names for look-up
purposes. Enter information to distinguish one patient from another. The "?" can be used as a

wild card character.

PATIENT SELECTION

Social Security:

Last Name:

First Name:

» < BROWSE > < CANCEL >
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With the above entry the last four digits of a social security number could yield the
following example:

Select from the following candidates:

[222222222] ARNOLD, ROSANNE

<Select> <Edit> <New> <Search> <Cancel>

Here the user has several options:

1) Place the cursor on the patient in the list and press <Select>,

2) Place the cursor on the patient and <Edit> the patient information,
3) Add a new patient, if the person was not found, <New>,

4) <Search> through the SAMS database for the person,

5) <Cancel> and abort the process.

4.4.1.3 Patient Enter/Edit. This option is called from the previous window when the user
selects <New>, <Edit>, <Search>, or the patient cannot be found. After the data is
entered the user either selects <OK > to save the record or <CANCEL > to abort the process.

Patient Enter/Edit
Social Security: 000 - 00 - 2222

Last Name: Anyone

First Name: Almost
Middle Initial: A

Date of Birth: 07/13/65

Sex: M

Rate/Rank: HM1

< CANCEL >

4.4.1.4 CANCEL. To cancel the Register Patient option, select the < CANCEL > option and
the menu window will close.
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4.4.2 Encounter.. When the Encounter option is selected from the Diagnosis Menu, the
patient seek function will be executed (see Section 4.4.1 above). If there is a pending encounter
on the current patient, the system will prompt to <Resume> the current encounter, create a
<New> encounter for the same complaint, or to <Cancel> this session.

System File Edit Diagnosis Window

Pending Encounters

Patient 123456789

Date 09/28/92

10:02:32 Acute abdominal pain

<Resume> < New > <Cancel>

Press the Fl key for help

After a selection has been made the following screen will appear:

System File Edit Diagnosis Window

Patient Encounter
Date 09/28/92 Time 10:02 Status P Provider 1
Patient Name DOE First JOHN
SSN 123-45-6789 Sex M Age 45

Symptom <Assist>
AGE
<Treatment >
< OK > <Cancel>
<Print > <<Save>> <Cancel>

Data contained herein are subject are subject to the privacy act of 1974.
Afford protection in accordance with SECNAVINST 5211.5C
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For a new encounter, the first button to be selected is <Complaint>. When the

complaint button is activated the following window will pop-up:

System File Edit Diagnosis Window

Patient Encounter

Date 09/28/92 Time 10:02 Status P Provider
Patient Name DOE First JOHN
SSN 123-45-6789 Sex M Age 45
<Complaint > <Diagnosis>
Complaints
AGE Acute abdominal pain
Acute chest pain <Select>
<Cancel>

{ [v
< I > 1,'

Once the complaint has been entered, the symptom information can be added. Notice
that the first information in the symptom window is age. If this was a pending encounter, the

some of the symptom information may have already been entered.

System File Edit Diagnosis Window

Patient Encounter

Date 09/28/92 Time 10:02 Status P Provider 1
Patient Name DOE First JOHN
SSN 123-45-6789 Sex M Age 45
<Complaint > Acute Abdominal Pain
: <Assist>
AGE
<Treatment >
< OK > <Cancel>
<Print > <<Save>> <Cancel>

Data contained herein are subject are subject to the privacy act of 1974.
Afford protection in accordance with SECNAVINST 5211.5C
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Select the <Symptom> button to continue entering information. When this button is
selected the question window will open. After answering the question, either select <OK> to
accept the answer or <Cancel>. Cancel will stop the question and answer session.

System File Edit Diagnosis Window

Patient Encounter
Date 09/28/92 Time 10:02 Status P Provider 1
Patient N
SSN 123-4

Which of the following best describes the site of the
<Complain| pain at ONSET

| va-
[ ] RIGHT UPPER QUAD [ ] LEFT HELP N
AGE [ ] LEFT UPPER QUAD [ ] CENTRAL A
[ ) RIGHT LOWER QUAD [ ] GENERAL 4
( ] LEFT LOWER QUAD [ ] RIGHT FLANK
[ ] UPPER HALF [ ] LEFT FLANK
[ ] LOWER HALF [ ] NO PAIN AT ONSET v
[ ) RIGHT HALF S |

«
»

< OK > <Cancel>

When all of the questions are answered, the <Diagnosis> button should be selected.
This button allows the user several options <Select> the marked diagnosis, <View> a
description of the marked diagnosis, or <Cancel>. this button can be used when adding
treatment information into the encounter form using the Edit Menu.

System File Edit Diagnosis Window
Patient Encounter

Date 09/28/92 Time 10:02 Status P Provider 1
Patient Name DOE First JOHN
SSN 123-45-6789 —————————Djseases on File
|
<Complaint > A
Sym NON "SPECIFIC ABDOMINAL PAIN +4 sist>——va—
RENAL COLIC B |
AGE PERFORATED DUODENAL ULCER A
CHOLECYSTITIS 4
SMALL BOWEL OBSTRUCTION
PEPTIC ULCER DISEASE
MESENTERIC ADENITIS v
DIVERTICULITIS A4 |
|
YA
< View > <Cancel>
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Once the diagnosis is entered, select the < Assist> button for the computer to compute
a diagnosis. When this button is selected a calculating sign will appear.

System File Edit Diagnosis Window
Patient Encounter

<Complaint > Acute

Date 09/28/92 Time 10:02 Status P Provider 1
Patient Name DOE First JOHN
SSN 123-45-6789 Sex M Rge 45

abdominal pain

<Diagnosis> APPENDICITIS

< One moment > Ya—
|
AGE Calculating... A
SITE AT ONSET AL PAIN 4
SITE AT PRESE
NAUSEA
APPETITE v
e |
<Treatment > -i
<Print > <<Save>> <Cancel>

The most likely diagnosis will appear first in the window, and any others will follow
beneath. The next step would be to enter <Treatment>, <Print> the encounter,
< <Save> > it to file, or <Cancel> to exit. The treatment field is a word processing field
and is edited using the Edit Menu.

System File Edit Diagnosis Window
Patient Encounter

<Complaint > Acute

Date 09/28/92 Time 10:02 Status P Provider 1
Patient Name DOE First JOHN
SSN 123-45-6789 Sex M Age 45

abdominal pain

<Diagnosis> APPENDICITIS

SITE AT ONSET
SITE AT PRESENT

< Symptom>-———————y 4— <Assist> ———————va—
n I
AGE 45 A APPENDICITIS A

RIGHT LOWER Q4
RIGHT LOWER

NON SPECIFIC ABDOMINAL PAIN ¢

NAUSEA Y I
APPETITE DECREASED v v
B |
<Treatmen YA

<Print > << <Cancel>

Data contained herein are subject are subject to the privacy act of 1974.
Afford protection in accordance with SECNAVINST 5211.5C
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To print the patient encounter select the <Print> button on the Patient Encounter form.

The user has an option of printing the information to a file or printer.

Print Encounter Report Function:

Save an encounter to another file

1) Select (x) File

2) Type in a name after Filename:

3) Select <OK>

Print an encounter:

1) Select (x) Printer
2) Select <OK> (make sure the printer is turned on before choosing <OK>.

System File Edit Diagnosis

Patient Encounter

Patient Name DOE
SSN 123-45-6789

<Complaint> Acut

Window

Date 09/28/92 Time 10:02 Status P Provider
First JOHN
Sex M Age 45

ITIs

Print Encounter

s

AGE

Print Encounter to: (*) File

( ) Printer

SITE AT ONSET
SITE AT PRESEN

NAUSEA
APPETITE

Filename: ¥

st>—va—

—=

A
NAL PAIN¢

<Cancel>

<<Save>> <Cancel>

Afford protection in accordance with SECNAVINST 5211.5C

Data contained herein are subject are subject to the privacy act of 1974.
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4.4.3 Disease/Treatment Lookup. This option allows the user to lookup the disease description
and treatment protocol. The Disease/Treatment description contains seven sections: Disease
Description, Discussion, Differential Diagnosis, Treatment of Disease, Usual Course with
Treatment, Complications and Their Management, and Complications and Their Management.

When the Disease/Treatment Lookup option is selected from the Diagnosis Menu the
following pop-up list of descriptions or treatment information will appear.

DISEASE/TREATMENT REFERENCES

ACUTE PANCREATITIS

CHOLECYSTITIS
DIVERTICULITIS

GASTRITIS

GASTROENTERITIS

HEPATITIS

INGUINAL HERNIA

MESENTERIC ADENITIS
MYOCARDIAL INFARCTION
NON-SPECIFIC ABDOMINAL PAIN

< Select>

Disease/Treatment References

To end this process select < Quit> or view any particular Disease or Treatment

description simply selected the disease on the scrolling window, then select the <View > push
button (see Section 3.5).
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The following window of disease descriptions will appears. Select <OK> when

finished.

Disease Description

Appendicitis (APPEND) Acute appendicitis
Acute appendicitis results from a bacterial invasion of the appendix with
inflammation. Incidence is highest in adolescents and young adults,peaking
between ages 15 and 24. Typically the pain is initially poorly localized in the
periumbilical region. This pain represents irritation of the lumen of the
appendix itself. Gradually the pain shifts to the right lower quadrant,

becoming constant and discrete as the inflamed appendix begins to irritate the
Anorexia, fever and diminished bowel sounds are
usually noted; nausea, vomiting and diarrhea are variable. Temperature, pulse
and respiratory rate may be only slightly elevated unless perforation occurs.

surrounding peritoneum.

< OK >

4.4.4 SF600 Report. This option extracts the encounter data and compiles it into the SF600
report format. The report can either be sent to a printer or stored in a file. The editor allows
this report to be modified. See Appendix B for The Table of Text Editor Commands. When
selecting the SF600 Report from Diagnosis Menu popup, the following window appears:

Social Security:
Lastname:

h Firstname:
Encounter Date:

« OK

»

Encounter to Report

/1

< BROWSE > < CANCEL >
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This option allows the user to fill in Social Security, Last name, First name or encounter
date. If any field is unknown leave it blank. The input process allows partial information to
be entered, use ’?’ as a single unknown character. To look up the existing patient encounter
in the system, at least one field must be entered. Select <OK> when done, <Browse> to see
the entire patient encounter listing, and <Cancel> to abort the process.

Patient in File

(0000000001} Example One

< Select > < Cancel >

Patient Selection

After the correct patient is selected, the system will search the encounter for a specified
date. Select <OK> to continue or <Cancel> to quit.

Patient: 000000001
Date: 9/29/92

000000001 14:44:38 Acute Abdominal Pain

< OK > <CANCEL>
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The report editing appears when it is finished the generate report.

Report Editing

This 26 Years old male presents with pain over his whole chest
which radiates to the left arm. The pain began about 2 days to a week
ago and was gradual in onset. The patient has been in continuous pain.
He describes the pain as sharp. Numbness is absent. The pain is
moderate in severity and seems to be getting worse since it began. By
history, coughing makes the pain worse and Pentaphenabarbitol and Gin
seems to make the pain better. The patient reports dyspnea associated
only this illness. The patient has no cough. Sputum is absent.
Orthopnea is absent. Paroxysmal nocturnal dyspnea is absent. Reflux

< Print > < Save > < Cancel >

The users should read the form carefully and necessary changes. Press <Save> to save
the change, <print> to output the report, <Cancel> to quit out the option.

The output device can be either a file or printer. Use arrow key or the mouse to select
the device. If choosing a <File>, remember to enter the filename at the filename field. Select
<OK>when ready send report to output device, or <Cancel> to stop the output report.

4.4.5 Encounter Training Mode. When this option is selected, information is stored in a
temporary files and not into the permanent data base. See Section 4.4.3 for detail.
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Appendix A: Encounter Forms
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Appendix B: Text Editor Commands
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Cursor Movements

Right Arrow Move one character to the right
Left Arrow Move one character to the left
Up Arrow Move up on line

Down Arrow

Move down one line

Home Move to the end of the line
End Move up one window-full of text
PgUp Move down one window-full of text

Ctrl + Right Arrow

Move one word right

Ctrl + Left Arrow

Move one word left

Ctrl + Home

Move to the beginning of text

Ctrl + End

Move to the end of text

Select text with key board

Shift Arrow Keys

Select a range of characters

shift Arrow Keys

Select a range of words

Shift + Ctrl Arrow
Keys

Select from cursor to beginning of text

Shift + Ctrl + End

Select from cursor to end of text

Ctrl + A

Select entire document
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Select text with Mouse
Drag Select a range of characters
Double-click Select a range of words
Double-click and Select from cursor to beginning of text
drag Keys
Triple-click Select from cursor to end of text
Triple-click and drag | Select entire document
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Delete and Replace

Place cursor to the
right of the
character, press
Backspace, or place
cursor at the
character, press
Delete

Delete a characters

Place cursor
anywhere in word,
press
Ctrl+Backspace

Delete a words

Select and press
Backspace

Delete a selection

Select text to be
replaced, type new
text (or Paste)

Replace existing text
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Cut, Copy and Paste

Select the text, press
Ctrl+X or use Cut
in the Edit menu

Cut Text

Select the text, press
Ctrl+C or use Copy
in the Edit menu

Copy Text

Press Ctrl+V or use
Il Paste in the Edit
menu

Delete a selection

Select text, press
Ctrl+V or use Paste
in the Edit menu

Replace existing text
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Appendix C: Diary/Calendar Commands
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Diary/Calendar Commands. At the bottom of the Calendar/Diary window are push buttons
used to change the calendar. These buttons correspond to first five options on the Diary menu

popup.

System File Edit Diagnosis Window
Back Month PgUp
Ahead Month Pgup
Back Year Shift+Pgup

Ahead Year shift+Pgbn

Today T
Diary Tab
Calendar shift+Tab
Delete...

Calendar Panel. The Calendar panel appears with the current month displayed and the current
day’s date selected. The month and year at the top of the calendar are highlighted when the
Calendar panel is active.

To change the selected date, use the arrow keys or click on the desired day. To change
the month backward or forward, use the PgUp and PgDn keys or the two month push buttons,
< M and M -, at the bottom of the window. to change the calendar backward and forward by
year, use shift+PgUp and Shift+PgDn or the year push buttons, < Y and Y -, at the bottom
of the window.

To select today’s date by pressing T on the keyboard or by choosing the TODAY push
button. This is quick way to get back to the current day.

Diary Panel. The Diary Menu popup contains options corresponding to those of the Calendar
Panel. There can be a diary entry for each day. To make a diary entry select the day in the
Calendar panel. Active the Diary panel by pressing Tab or clicking on the panel with the
mouse. The cursor flashes in the Diary panel, indicating that it is active.

The diary panel is a text region so the user can use standard text editing techniques.
There is no limit to the amount of text that can be enter. All dates that have a diary entry are
displayed as enhanced text.
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Delete Entries. Each diary entry is stored in the file until deleted by the user. The user refer
to these entries by selecting a date. These entries should be cleared from time to time to keep
from wasting disk space.

Diary entries are deleted backwards from a selected date. To delete the entry, select a
day on the calendar and choose Delete... from the Diary Menu popup. All text entries prior to
but not including that day will be erased. An alert appears to confirm the action. Choose Yes
to delete the entries. No will return the Calendar/Diary option without deleting any entries.

Delete all diary entries prior to 01/01/92?

< Yes > « No »
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Appendix D: Installation Guide

This Appendix contains the listings of the four files used in the installation of the CAMD
system; CAMDREAD.DOC, INSTALL.BAT, INSTALL.TXT and CAMD.BAT. The
CAMDREAD.DOC contains the instructions for installing the CAMD system. The
INSTALL.BAT is the batch file that installs the CAMD system from the three floppy disks to
the hard drive. The INSTALL.TXT contains the messages that are displayed during installation.
The CAMD.BAT is the batch file that starts the CAMD system once it has been installed.
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CAMDREAD.DOC

Computer Assisted Medical Diagnosis Installation. ‘

The CAMD system needs 3 Mega bytes on a hard drive. This installation package
includes three 5 1/4" low density floppy disks.

To install the CAMD system, complete the following:

1.

2.

Put the CAMD INSTALLATION DISK #1 into disk drive (A or B)

Goto floppy disk drive. Type A: or B:

. Type> INSTALL A: C: (A: the source drive (floppy), C: the destination drive).

This will start the installation batch file INSTALL.BAT).

. The installation will display a message requesting the next disk. Put in

disk #2 in floppy drive and press ENTER. This process will be continued
for disk #3. After disk #3 is done, Put disk #1 back into the source
drive.

. In the root directory (C:\) modify or add the FILES and SHELL commands

in the CONFIG.SYS file. The FILES command should be set to 50 or more
(FILES =50). The SHELL command should read (SHELL=COMMAND.COM /P /E:512)
for DOS 3.2 and higher and (SHELL=COMMAND.COM /P /E:32) for DOS 3.1 and

below.

6. Reboot the computer.

7. At the DOS prompt type C:\CAMD >CAMD to start (execute) the CAMD system.

This will start the CAMD.BAT file.

8. The password is CAMD.
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INSTALL.BAT

echo off

:install.bat hll@nhrc

if "%2"=="" goto L1
cls

type install.txt

pause

cls

md %2\camd

cd %2\camd

copy splice.com %2
%2

splice % 1\camdata.exe
camdata.exe -d

splice % 1\camdsrc.exe
camdsrc.exe -d

del camdata.exe

del camdsrc.exe

del splice.com

cls

echo Remove Disk from Drive
echo CAMD installation completed!!!
echo

echo Note: Go to root directory, modify or add the FILES and SHELL

echo commands into CONFIG.SYS file, the FILES command should be set to 50
echo or more (FILES=50). The SHELL command should read

echo (SHELL=COMMAND.COM /P /E:512) for DOS 3.2 and higher and

echo (SHELL=COMMAND.COM /P /E:32) for DOS 3.1 and below.

echo Reboot the system.

echo

goto end

:L1

echo format: INSTALL s: d:

echo s: source drive (a: or b:)

echo d: destination drive (c: or d:) to install the camd system.

:END
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INSTALL.TXT
This will install the Computer Assisted Medical Diagnostic System.

This installation will create a subdirectories \CAMD on your destination

drive. You will need a minimum of approximately 3 MB of space available

for all the necessary files. In the root directory (C:\) modify or add

the FILES and SHELL commands to the CONFIG.SYS file. The FILES command
should be set to 50 or more (FILES=50). The SHELL command should read
(SHELL=COMMAND.COM /P /E:512) for DOS 3.2 and higher and
(SHELL=COMMAND.COM /P /E:32) for DOS 3.1 and below.

If the \CAMD subdirectory is not on the same drive as the \SNAP
subdirectory, modify the CAMD.BAT to set the appropriate drive and path
in the system environment.

If you want to discontinue the installation, hit Ctrl-C.
If you have any questions regarding the installation, call:

D.M. Pearsall (Dee)

Naval Health Research Center

P.O.Box 85122, San Diego, CA 92186-5122
DSN or Commercial 553-8401 Area Code (619)
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CAMD.BAT

echo off

:This runs the CAMD demo from MS-DOS and
:establishes path and environment variables
:This camd.bat not hard code SAMS environment to specific drive. It assume
:was CAMD system has same drive with SAMS.
IF not "%camd%"=="" goto LO5

:this is the data path

set camd=\camd\data

:L05

IF not "%sams%"=="" goto L1

:this is the sams system path

set sams=\snap\sams

:L1

IF not "%camdx%"=="" goto L2

set camdx =\camd\bin

:L2

if not exist %camd %\system.dbf goto usage

if exist %camdx %\camd.exe goto camdex

goto end

:camdex

:run DOS executable

cd %camdx %

camd

goto end

‘usage

echo File not found %camd %\system.dbf

echo You must be on disk with %camd% directory
:end

cd..
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